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1. Introduction

Welcome to BLUETILL
BLUETILL is a powerful multi-user business software that manages every aspect of the business
workflow cycle – from stock control, sales activities, servicing and customer contact to invoicing,
financials and reporting, as well as email communication.

contact us by email
Ph : +61 411 389 336

BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 3 of 161

mailto:support@bluetill.com


2. Support

Have questions? We’ve got answers.
Please send email to support@bluetill.com or call to +61 411 389 336

New Customer Support
After purchasing the BlueTill, you can get free 12 months Phone, TeamViewer support.
You can download BlueTill teamviewer file. Click here
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3. What’s New
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4. Compare Editions
Essential Edition Professional Edition

Item Register Y Y

Category, Supplier, Brand Y Y

Pos Sale Y Y

Pos Touch Y Y

Refund Y Y

Connect Receipt Printer Y Y

Connect Cash Drawer Y Y

Connect Barcode Scanner Y Y

Reprint Receipt Y Y

Use Table Number Holder Y Y

Shift (X & Z Report) Y Y

Item Modifier Y Y

Tyro Integration Y Y

Westpac EFTPOS Integration Y Y

Kitchen Printer Y Y

Sales Report Y Y

Graph Report Y Y

Training Mode Y Y

Staff Maximum Discount Management Y Y

Staff Price Change Management Y Y

Paid In & Paid Out Y Y

Package Item Y Y

Export to MYOB Y Y

Layby N Y

Waste Management N Y

Table Order Assignment N Y

Customer N Y

Customer Discount Level N Y
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Quotation N Y

Pro Forma Invoice N Y

Invoice N Y

Credit memo N Y

Receive Invoice Payment N Y

Statement N Y

Delivery Setup for Individual Item N Y

Period Discount N Y

Purchase Order N Y

Receive Inventory N Y

Return to Supplier N Y

Bill Payment N Y

Adjustment Inventory N Y

Quick Adjustment Inventory N Y

Barcode Print N Y

Loyalty N Y

Gift Voucher N Y

Liquor Module N Y

Batch Item Management N Y
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5. Getting Started
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5.1. User Interface
The BLUETILL User Interface is intuitive and easy to use. The ability to efficiently access and view live
information is achieved using familiar Windows techniques, including left/right mouse click, double click,
drag and drop, and drop-down menus. There are four main areas in the user interface.
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5.1.1. Icons

1
Quick access to business activities including pro forma invoice, invoice, POS, cash up, purchase,
delivery and back order trackdown

2 View Item list

3 Pos sales screen

4 Pos sales screen for touch screen devices

5 Create purchase order

6 Create supplier’s invoice

7 Open delivery

8 Create Pro forma invoice

9 Create invoice for customer

10 Create credit memo for customer

11 Receive payments from customer

12 View reports

13 View charts

14 Exit BLUETILL
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5.1.2. Window Menus
1. File

1 Setup receipt printer, receipt header, receipt footer and cash drawer

2 Setup Tyro and Westpac Presto Smart EFTPOS terminals

3 Setup screen button for POS touch screen

4 Setup payment type

5 Setup tax code and rate

6 Setup company details, terms and conditions on invoice, email and other options

7 Import data from Xero, BizManager

8 Export data

9 Exit BLUETILL

2. Lists
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1 View stock. You can add, edit or delete stock

2 View categories. You can add, edit or delete categories

3 View suppliers. You can add, edit or delete suppliers (vender)

4 View customers. You can add, edit or delete customers

5 View staff. You can add, edit or delete staff

6 View brands. You can add, edit or delete brands

7 View freight. You can add, edit or delete freight

8 View sizes. You can add, edit or delete sizes

9 View colours. You can add, edit or delete colours

10 View styles. You can add, edit or delete styles
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5.1.3. Login

1 Company Name

2 Login. It displays the device’s till number

3 Exit BLUETILL

4 Training. Selects training mode using sample database (it doesn’t affect the company’s data).

5 Clear entered password

Training mode denies access to the system preferences and denies use of the EFTPOS
terminal.*
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5.2. Workflow
This provides more accurate information in your list monitoring to identify where, when and if your work
processes require attention.
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5.3. Add Basic Items
Basic items are individual inventory items sold without multiple options or variations, such as modifiers
or kitchen printer connections.

Create a Basic Item

Enter details such as item name, category, supplier (vendor), retail price, wholesale price and cost price
of inventory item.

1. Open Stock (Items) Screen.

2. Click ‘Add New’.

3. Fill in item details.

SKU Unique identifier created for each item and used to generate barcodes.

Stock No
Item reference. You can use this field as the vendor’s (supplier’s) item code as sometimes
vendors use their own code rather than a barcode and you will need it to order the item.

Sales
Description

What cashiers see at the register and what prints on receipts. Cashiers can search for items
by Name on the Sales screen.
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Pop Up
Price for
Pos

If you choose this option, a popup screen will show whenever you select the item in the Sales
screen prompting you to enter a price.

Pop Up Qty
for Pos

If you choose this option, a popup screen will show whenever you select the item in the Sales
screen prompting you to enter a quantity.

Package

If you choose this option, you can setup a package item which includes several items each
with individual quantities. Whenever you select a package item, linked items will be displayed
on the Sales screen and their individual quantities will decrease from the inventory after you
complete a sale.

SKU2
2nd unique identifier for the item. If you setup an item with SKU = 100 and SKU2 = 101,
whenever you scan/type 100 or 101 in the search bar, item will be selected and displayed.

Purchase
Description

You can use this field if you want to use a different description when you order from a vendor
(supplier).

Retail The amount the item sells for to a retail customer.

Wholesale The amount the item sells for to a wholesale customer.

Cost The amount that has to be paid for the business to acquire an individual item.

Unit / Order
Unit

The quantity amount that will increase whenever you buy the item as ‘Order Unit’. Eg. If you
set up order unit qty as 12 and buy 1 item as order unit, total stock quantity for that item will
be increased by 12.

Order Unit
Name

The name of the order unit. The default name is ‘Box’.

Unit / Sales
Unit

The quantity amount that will decrease whenever you sell the item as ‘Sales Unit’. Eg. If you
set up sales unit qty as 12 and sell 1 item as sales unit, total stock quantity for that item will
be decreased by 12.

Sales Unit
Name

The name of the sales unit. The default name is ‘Box’.

Sales Unit
Price

The amount the item sells for when sold as a sales unit.

Brand
Brand of the item. You can use brand instead of supplier when you search. Most users use
brand instead of supplier when they want to hide the vendor’s (supplier’s) name from staff.

User Field
Users can setup their own data field for items for any purpose. For example, you can use this
field to describe the item’s location in the warehouse.

4. Add a Package Item
Step 1 : Select the ‘Package Item’ check box.

Step 2 : Click the ‘Package’ button at the bottom of the screen.
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Step 3 : Click the ‘Select Items’ button then select the items that you want to include in this package.

Step 4 : Double click the ‘Qty’ column to change the qty.
Step 5: Click the ‘Close’ button (when you close the screen, the selected package items will be saved
automatically).
Step 6 : Click ‘Save’ on the item edit screen.
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5.4. Add Items with Variants
Modifiers can be added to basic items to add multiple variants to a single item such as drinks with
different cup sizes.
Modifiers can be single choice or multiple choice which allow customers to personalize their order.
With Modifiers, a customer can select how they’d like their burger cooked, which additions (i.e. extra
bacon) they’d like, and if they’d prefer not having an ingredient (i.e. the bun) due to allergies or personal
preference.

Open Modifier screen on item edit screen

Single Choice Modifiers
Single choice modifiers allow customers to make just one selection from a group of several potential
choices. For example, choosing between mild, spicy, or extra spicy salsa with an order of chips.

Add Modifiers to an Item
You can setup 4 different single choice modifiers. Each selection has 14 potential choices.

1. Click the modifier button.
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2. Enter a name and an optional price. Optional price increases the item’s sales price when that option is
selected at the register.

3. Select an optional kitchen printer.

Multiple Choice Modifiers
If you run a cafe or restaurant, some items can have extra additions or options that can be added to the
item. Clicking on the ‘Multiple Choice’ button will open another screen to choose for multiple choice
modifiers of which any number of options can be selected.

Add Modifiers to an Item
You can setup up to 56 different options. Adding a multiple choice modifier is the same as single choice.
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Copy Modifiers from an Item
For items that would use the same modifiers, you can copy the modifiers from an existing item over to
other items. This allows you to avoid reentering modifiers one by one.

1. Click the ‘Copy From’ button to search for an item to copy modifiers from.
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5.5. Register Button Layout
The Pos touchscreen button layout is the layout of screen buttons that cashiers use to ring up inventory
items. Learn how to navigate and add items to the layout.
Click Here for instruction
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5.6. Opening & Closing Your Shift
Open and close shifts to maintain accurate reporting and make it easier to balance your cash drawer
each day.

Open Shift
One of the first steps to starting your day is to open a shift. The shift must be open before cashiers can
run any transactions at the register.

1. Open BLUETILL and login.
2. Open the Pos Sale or Pos Touch screen (may require another login).
2.5. Pos Touch only: Click the ‘Functions’ button at the bottom of the screen.
3. Click the ‘Shift’ button.

Pos Touch

Pos Sale

4. Click ‘Open Shift’.
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5. Enter the starting cash amount in the till.

Close Shift
When your business closes each day, close the shift in BLUETILL to end your day. After the shift is
closed, cashiers cannot run anymore transactions.

1. Click ‘Close Shift’.

2. Enter the total cash amount left in the drawer

3. Enter the total amount of each other payment method.

Once you open the Shift, the ‘Open Shift’ button will change to ‘Close Shift’.*
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5.7. X and Z Reports
X and Z reports provide summaries of activity on a particular register during a shift. Both reports include
opening/closing drawer amounts, sales/returns totals, and other shift details.

X Report – Mid Day / Mid Shift
The X report is a snapshot of shift details from the beginning of the shift up to the present on that
specific register.

Z Report – End of Day / End of Shift
The Z report is a snapshot of what occurred from the beginning of the shift to the end of the shift on that
specific register.
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6. Setup
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6.1. EFTPOS Terminal
Currently BLUETILL supports Tyro and Westpac Presto EFTPOS.
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6.1.1. Westpac Presto
Select ‘EFTPOS Terminal Setup’ under the ‘File’ Tab

You can download Presto Smart VX690 User Guide

Pairing Guide
Terminal

The terminal idle screen displays information such as the battery strength, connection strength, Serial
Number, Network name, IP address, and the button to initiate Pairing the POS.
The payment application’s main menu/idle screen can be accessed via the key combo “ENTER+3”.

BlueTill
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1. Select Westpac for the Terminal Type.
2. Enter the EFTPOS IP address eg. 192.168.1.100.
3. Enter the EFTPOS Serial No.
4. Click the ‘Save’ button
5. Click the ‘PAIR’ button
6. Click Pair with POS on the EFTPOS Terminal that you are pairing with.

Pair Processing on Terminal

7. The terminal will now display a 6-digit secret key. This 6-digit secret key will also be displayed on the
BlueTill screen.
Please ensure both POS and terminal is showing the same key to continue with the pairing.
Press “Yes” on the terminal screen to confirm the key.

BlueTill
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Terminal

Unpairing Guide
1. Click the ‘UNPAIR’ button.

2. Terminal

Note: You will only have 60 seconds to complete the pairing process before it times out.*
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Press “ENTER + 3” on the EFTPOS terminal to begin the unpairing process. Enter the Merchant
password and press “Enter” then select “Unpair Terminal”. The terminal should show “Please pair device
with your POS” to indicate it is unpaired.

Standalone Mode
Press “1 + ENTER” on the EFTPOS terminal on Pair with Pos screen

You can enter the amount manually.

Back to Pair with Pos screen on Standalone Mode
Press “X” on the EFTPOS terminal
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6.1.2. Tyro

Before you start

1. Tyro Terminal Adapter Software (TTA)

You need to install the Tyro Terminal Adapter Software (TTA). Click here for download or type the URL
on the browser (tyro.com/tta).
This software needs to be installed and configured on each workstation that you wish to access the Tyro
terminal.

2. Tyro Terminal

If this is the first time you are setting up Tyro, call Tyro Support on 1300 966 639 to activate the terminal.
They will supply you with a Merchant ID and a Terminal ID.

Pairing the Tyro Terminal with your PC
This process has to be repeated on each PC that you want to link to the Tyro terminal.

On the Tyro terminal

1. On the Tyro terminal, tap Menu, then Configuration

2. Select Integrated EFTPOS, then Pair with POS
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3. On the Tyro Terminal, tap Pair (or Retry if you have already attempted to Pair)

4. After paired, you can see the following screen
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On the PC

1. Click the Tyro Terminal Adapter to load the Tyro Terminal Adapter configuration software on Control
Panel

2. Fill the Merchant ID, Default Terminal ID and Pos System Name (BLUETILL).
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3. Click Save and Pair. If the pairing is successful it will return to the pairing screen.
Confirm the pairing by clicking on Verify Key on the Tyro Terminal Adapter.

On BlueTill Point of Sale

1. Select ‘EFTPOS Terminal Setup’ under the ‘File’ Tab

2. Select Terminal Type to Tyro

BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 34 of 161



BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 35 of 161



6.2. Surcharge
Open ‘Preferences’ under the ‘File’ tab.

Setup Surcharge Option

Choose Surcharge Type and Enter the percentage or amount

Minimum Sale
Amount: Fixed
amount

The surcharge will be applied if card payment amount is under a specific amount.
And surcharge amount is fixed like a 0.20 (20 cent).

Minimum Sale
Amount: Fixed
Percentage

The surcharge will be applied if card payment amount is under a specific amount.
And surcharge amount is percentage of card amount. 1 means 1%.

Fixed Percentage
The surcharge will be applied to card payment amount with fixed a percentage. 1
means 1%.
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Surcharge Applying Payment Screen
If the surcharge is activated, surcharge screen will be displayed on payment screen.
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6.3. Receipt Printer
Open ‘Pos Hardware setup’ under the ‘File’ tab.

Setting up your receipt printer for a Windows PC

1. Tick the ‘Receipt printer’ check box.
2. Type the printer name in the text box.
3. Setup the Header and Footer.
3. Click the ‘Test Print’ button. If it prints successfully, click the ‘Save printer setting’ button and the
‘Header’ and ‘Footer’ ‘Save’ buttons.

If the printer connection type is USB, you need to download and install the printer driver.
After that, you can check the receipt printer settings in Control Panel > Devices and
Printers
*
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6.4. Kitchen Printer
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6.5. Cash Drawer
Connect to Receipt Printer

1. Plug the RJ12 connector cable (the one that looks similar to a phone line) from the cash drawer into
the receipt printer.
2. Tick the Cash Drawer checkbox
3. Click the ‘Test Open’ button to check if it is working.

Connect to Serial Port

1. Prepare a Cash Drawer trigger.
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2. Connect the trigger to computer

• One end of the Box has a USB-B port, plug the USB cable into that end

• The other end is a Standard USB-A connector. This plugs into one of the USB Ports on computer
• The Cable which comes from the Cash Drawer has the RJ12 connection. Which looks like a Phone

cable. Plug that into the connection on the black box
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3. Check the Serial Port on Control Panel

• Go to CONTROL PANEL
• Click on DEVICE MANAGER
• Click on the PORTS (COM & LPT) as in below picture
• There should be one listed as “Prolific USB-to-Serial COMM Port” as highlighted below
• Note down what COM number is has in brackets. The below example is COM3
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4. Set up the cash drawer on screen

• Make Sure RECEIPT PRINTER box is UN-TICKED
• Make sure CASH DRAWER box is TICKED
• Make sure CONNECT TO SERIAL PORT is selected in the drop down field
• In the SERIAL PORT FIELD, select the COM Port which was displayed on the previous page in

DEVICE MANAGER (our ex- ample was COM 3, yours will most likely be a different COM Port)
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• Then press TEST OPEN, and the Cash Drawer will fire open
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6.6. Register Button Layout
The Pos Touch screen button layout is the grouping of screen buttons that cashiers use to ring up
inventory items. Learn how to navigate and add items to the layout.

Open ‘Quick Button Setup’ under the ‘File’ tab.

You can set up 16 pages and each page can set up 24 items
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Add a Page
1. Click the page button (the blue buttons) to create a page (if a page has already been made for
that button, clicking it once will select the page, and clicking it again will let you edit the page
name).
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2. Type the name and click the ‘Enter’ button.

Add a Page Item
1. Click a page button that has been made.

2. Click a page item button (the yellow buttons).

If you want to delete the page, click the ‘Remove Page’ button.*
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3. Search the item that you want to add.

You can search the item with item name.

4.Click the ‘Add Page Item’ button at left bottom.

If you want to delete the button, just click the ‘Remove Page Item’ button at left bottom.*
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Edit Group name

1. Click ‘Preferences’ under the ‘File’ tab.

2. Go to the ‘Quick Button’ tab, type the group name and click ‘Save’.

Currently, there are two groups by default and they cannot be removed or have more
groups added. Each group has 16 pages and each page has 20 items.

!
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6.7. Register Button Layout with image
If you want to add an image on the button, you need to activate the quick button image option.

Open ‘Preference’ under the ‘File’ tab.

Select Use Image option
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Add a Page Item and Image

Step 1 Select the button.

Step 2 Search the item.

Step 3 Click ‘Add Page Item’ button.

Step 4 Click ‘Change Image’ button. The best image size is 165 × 135 pixel.

After adding the item and assign the image.
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If you need to change the image, you can use the ‘Change Image’ button.*
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6.8. Tables (optional)
1. Click ‘Table Setup’ under the ‘File’ tab

2. Setup Tables

Activate table

Step 1 : Click ‘Change Name’.
Step 2 : Click a table button has ‘NA’ title.
Step 3 : Type the button title eg. ‘T1’, then click ‘Enter’.

If a table’s title is ‘NA’, it is an inactivated table and will not show during sales.*

BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 53 of 161



Change table colour

Step 1 : Click ‘Change Colour’.
Step 2 : Select colour.

Step 3 : Click the tables that you want to change the colour of.

‘Change Colour’ button’s back colour will change after you make a selection so you
know which one is selected.*
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6.9. Email
1. Click ‘Preferences’ under the ‘File’ tab

2. Go to Email

3. Setup Email Details

Purchase Email
You can use this email address when you send a purchase order email to the vender
(supplier).

Sales Email You can use this email address when you send a sales invoice email to the customer.

Email User
Name

Email username used when you access your email account to send an email.

Email Password Email password used when you access your email account to send an email.

Port Outgoing (SMTP) port. For example, gmail port is 465 or 587.

Smtp Host Outgoing (SMTP) email server. For example, google email server is smtp.gmail.com.

Email Logo You can insert a small logo when you send an email.

Use Outlook
Server

Select this option if you want to use the outlook application rather than send an email
through BlueTill.
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If your email server uses secure connection like a TLS or SSL, BlueTill will configure it
automatically.*
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6.10. Options

Use Table Number Holder and Print Table
No. on Receipt

Enter the Table Holder Number when making a sale on the
Pos Touch screen.

Use Reference as Order No. on Receipt
Print reference on receipt when invoice prints on the receipt
printer
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6.11. Payment Setup
1. Click ‘Payment Setup’ under the ‘File’ tab

2. Payment Setup Screen

New Add new payment type

Edit Edit payment type

Delete Remove payment type

If you want to connect Tyro or Westpac Presto EFTPOS, you can set it up in ‘Eftpos
Terminal Setup’. Click here for Westpac Presto instruction*
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6.12. Export to MYOB
1. Open ‘Preferences’ under the ‘File’ tab

2. Go to MYOB

3. Setup MYOB Details

MYOB
Service
Account
No

Sales or Credit Invoice will export to MYOB as a service item invoice because BLUETILL
doesn’t handle MYOB inventory item. A MYOB service account number and service item code
will be required to generate the export text file. Click Here for instruction

MYOB
Service
Item Code

MYOB service item code for exporting the invoice item.

MYOB
Freight

If the item code is ‘FREIGHT’, this item will export to MYOB’s freight.

MYOB
Cost of
Sales

When exporting purchases (Received Item Invoice), BLUETILL uses the Cost of Sales
account number in MYOB. Click Here for instruction
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Account
No

4. Setup MYOB Card ID for Customer

Customer

5. Setup MYOB Card ID for Supplier

Supplier

How to export invoice to MYOB
How to export purchase to MYOB
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6.12.1. Setup MYOB service item code
1. Click ‘Inventory’ then ‘Item List’

2. Click the ‘New’ button

3. Setup Details

You can connect an existing service item.*
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3. Get the existing item’s service account number
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6.12.2. MYOB Cost of Sales Account No
1. Click ‘Accounts’ under the ‘List’ tab

2. Click the ‘Cost of Sales’ tab

You can set up a new Cost of Sales account no like a 5-1300.*
Please don’t use 5-0000 (Cost of Sales) or 5-1000 (Purchase) Account Number!
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6.13. Connect to Shopify

Generate credentials from the Shopify admin
Steps:
1. From your Shopify admin, go to Apps.

2. Click Manage private apps.

3. Click Create a new private app.

BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 64 of 161



4. In the App details section, enter a ‘BlueTill’ for your private app and a ‘support@bluetill.com’ as a
contact email address.

5. In the Admin API section, click Show inactive Admin API permissions.

6. Select the ‘Products’ and ‘Customers’, then change permission to Read and Write.
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7. When you’re done, click Save. You can see the BlueTill app.

Connect with BlueTill
1. Get the Shopify API and Password
After Save the Private Apps, you can get the Shopify API and password. BlueTill needs API key,
Password, and URL.
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2. Open Preferences on BlueTill menu, then go to Shopify.

Shopify Key Copy API key from Admin API

Shopify Password Copy Password from Admin API

Auth URL Copy Example URL from Admin API

BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 67 of 161



7. Lists
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7.1. Stock

Add New Add new item.

Add New Edit item.

Delete Delete the item (it doesn’t affect the sales history).

Search Search for item.

Refresh Refresh the Item list and remove all filters.

Import Direct Update item details by importing csv file.

Send to Save the item list to a csv file.

Trackdown Check the item’s activities such as sales, purchases and quantity adjustments.

Modifier Open the item’s modifier setup.

1. Create a Basic Item

SKU Unique identifier created for each item and used to generate barcodes.

Stock No
Item reference. You can use this field as the vendor’s (supplier’s) item code as sometimes
vendors use their own code rather than a barcode and you will need it to order the item.

Sales
Description

What cashiers see at the register and what prints on receipts. Cashiers can search for items
by Name on the Sales screen.

Pop Up If you choose this option, a popup screen will show whenever you select the item in the Sales
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Price for
Pos

screen prompting you to enter a price.

Pop Up Qty
for Pos

If you choose this option, a popup screen will show whenever you select the item in the Sales
screen prompting you to enter a quantity.

Package

If you choose this option, you can setup a package item which includes several items each
with individual quantities. Whenever you select a package item, linked items will be displayed
on the Sales screen and their individual quantities will decrease from the inventory after you
complete a sale.

SKU2
2nd unique identifier for the item. If you setup an item with SKU = 100 and SKU2 = 101,
whenever you scan/type 100 or 101 in the search bar, item will be selected and displayed.

Purchase
Description

You can use this field if you want to use a different description when you order from a vendor
(supplier).

Retail The amount the item sells for to a retail customer.

Wholesale The amount the item sells for to a wholesale customer.

Cost The amount that has to be paid for the business to acquire an individual item.

Unit / Order
Unit

The quantity amount that will increase whenever you buy the item as ‘Order Unit’. Eg. If you
set up order unit qty as 12 and buy 1 item as order unit, total stock quantity for that item will
be increased by 12.

Order Unit
Name

The name of the order unit. The default name is ‘Box’.

Unit / Sales
Unit

The quantity amount that will decrease whenever you sell the item as ‘Sales Unit’. Eg. If you
set up sales unit qty as 12 and sell 1 item as sales unit, total stock quantity for that item will
be decreased by 12.

Sales Unit
Name

The name of the sales unit. The default name is ‘Box’.

Sales Unit
Price

The amount the item sells for when sold as a sales unit.

Brand
Brand of the item. You can use brand instead of supplier when you search. Most users use
brand instead of supplier when they want to hide the vendor’s (supplier’s) name from staff.

User Field
Users can setup their own data field for items for any purpose. For example, you can use this
field to describe the item’s location in the warehouse.
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7.1.1. Stock List

Code contains Search an item that contains characters in the stock code (SKU).

Description
contains

Search an item that contains characters in the stock description.

Stock No Search an item that contains characters in the stock no.

Supplier Search an item that assigned selected supplier.

Category Search an item that assigned selected category.

Date Moved
Search an item that has Sold or Purchases item

movement in the selected date period.

Trackdown Search an item activities details.

Add Count

Stocktake.

Export Export to Excel.
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Activities

Run Run selected query.

Clear Field Clear the criteria for search.
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7.2. Category
Categories are item groups used for organising inventory and analysis in sales reports.
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7.3. Supplier
The supplier (vendor) or party from whom the item is acquired.
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7.4. Customer
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7.5. Staff

Open Staff Screen

Features

New Add new staff. If you click this button, staff edit screen will be displayed

Edit Edit staff details. If you click this button, staff edit screen will be displayed

Delete Delete staff

Search Search for staff

Refresh Refresh the staff list and removes all filters.

Change Password Change staff password

Each transaction (sale or purchase) records the staff code so if you delete the staff, staff
details won’t display properly.

!
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Edit Staff

Position

Each position has different security clearances / permissions. ‘Staff’ can make sales and
purchases but can’t register/edit an item and can’t see the report or access ‘Preferences’. The
manager can in addition to ‘Staff’ permissions, see the report but they can’t access
‘Preferences’.

Password
Each staff member requires a password to login to the Pos Sale/Pos Touch screen. They are
also used to check for permission access to certain features. Passwords are made up of digits
only.

Hide Cost
If you select this option, staff member can’t see the cost of the items in the stock list or lookup
screen.

Allow
Discount

If you select this option, staff member can apply discount during sales.

Allow
price
change

If you select this option, staff member can change the unit price of an item during sales.

Maximum
Disc (%)

If staff member is allowed to apply discounts, you can set up a maximum discount rate that
they can apply.

Allow
void
invoice

If you select this option, staff member can void invoices.

Allow
open
cash
drawer

If you select this option, staff member can open cash drawer without transaction.
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7.6. Brand
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7.7. Freight
BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 79 of 161



7.8. Sizes
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7.9. Colors
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7.10. Styles
BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 82 of 161



8. Sale Invoice
An Invoice is usually created when you deliver the items or services the customer ordered. Invoices can
be open (unpaid), closed (paid).
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8.1. Create Invoice
Open the ‘Invoice’ Screen

Select a Customer

1. Select a customer from the customer drop-down menu

2. Select a customer from the customer list screen

Add items

1. Type the item SKU in the code box and press ‘ENTER’ or click the ‘No’ column on the empty row

If you want to add new customer, just select ‘Add Customer’*
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2. Change item details

No Row number.

SKU Unique identifier created for each item and used to generate barcodes.

Stock No item reference.

Description Description of item.

Qty The quantity of the item.

Unit Price
The amount you are charging for one quantity of this item. If you want to set the price as ‘tax
exclusive’, change the ‘Amounts are’ option to Tax Exclusive in the top right hand corner of
the grid.

Disc [Optional] The volume of discount as a fraction (eg. 0.1 = 10% discount).

Tax Rate Tax Rate. (0.1 is 10% tax rate).

Amount The total price of the item (inclusive of quantity, discount amount, and tax amount).

Tax
Amount

The total tax amount for the item.

Unit/Sales
Unit

The quantity amount that will decrease when you sell item. Eg. if the sales unit qty is ‘12’ and
the selling qty is ‘2’, total stock quantity will be decreased by 24.

Single
Sales Unit name. If you select Single, total stock quantity will be decreased by 1. If you select
Box, total stock quantity will be decreased by the box quantity.

Delete Removes the item from the grid

Quick Inq. (Quick Inquiry) Searches the item sale history for the invoice customer.

Click the column you want to change and type the number. Then press ‘Enter’ key.
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Enter additional information about the sale

Delivery
Address

If the delivery address is different to the billing address, you can use this address for
delivery.

Attention The name of the person who is supposed to receive the delivery

Telephone Telephone number for the delivery.

Memo Memo for the invoice.

https://www.youtube.com/embed/-Q_Zg72sMCQ?rel=0
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Sales person The name of the salesperson.

Order person The name of the order person.

Pro Forma Invoice # List of Pro Forma Invoice no’s that have been imported.

Quotation Invoice # List of Quotation invoice no’s that have been imported.

Reference Reference for the invoice.

Print, send or save it as a PDF

After saving the invoice a message box will popup asking If you want to print, send email or save it as a
PDF.
Otherwise, if you open an existing invoice and wish to print, click the ‘Send To’ button.

Print options

PDF for Delivery Note Save delivery note as a PDF.

Delivery Note Show preview delivery note.

Email Send email. Click here for email setup instruction

Preview Show preview invoice.

Save PDF Save invoice as a PDF.

Docket Print invoice to docket printer. Click here for docket printer setup instruction
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8.2. Find an Invoice
Open the ‘Quick Insight’ screen

Step 1 : Select a date period
Step 2 : Click the ‘Invoice’ button
Step 3 : Select an invoice option that you want to look up
Step 4 : Click the ‘Load Data’ button

1. ‘Invoice by Date’ includes all the invoices in that specific period.
2. You can also filter by customer from the customer drop-down menu.*
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8.3. Edit or Void Invoice
From the ‘Invoice Option’ drop-down menu, select ‘Edit’ to edit the invoice or ‘Void’ to void the invoice.

If you can’t see the ‘Invoice Option’ drop-down menu, there are two reasons.
(1) Payment has already been made for this Invoice even if it is only partial payment.
(2) The Invoice has generated a ‘Rebate Credit Memo’ automatically. ‘Rebate Credit
Memo’ is an optional module. Please contact us if you are interested in.

*
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8.4. Add Payment to Invoice
When customers make payments for invoices, you can record the payments in the ‘Receive Payments’
screen for one or more invoices or you can record the payment in the ‘Invoice’ screen for an outstanding
invoice.

Apply the payment to an open invoice in the Invoice screen.

Apply the payment to one or more open invoices.

1. Select the Customer.
2. Type the amount received next to ‘Amount’.
3. Select the payment method.
4. Enter the amounts you want to apply to one or more invoices in the ‘Payment’ column. If you click the
‘Pay’ button, invoice’s due amount will be filled automatically.

Total Total payment amount made by the customer.
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Cash
Amount

Applied
Credit

Total amount of credit currently being applied to invoices.

Applied
Cash

Total amount of cash currently being applied to invoices.

Payment
Balance
Left

The amount of cash that is yet to be applied to invoices calculated from the ‘Total Cash Amount’
minus the ‘Applied Cash’ amount. The ‘Payment Balance Left’ must be zero before you can
record the transaction.
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8.5. Handle a Credit Balance
There are two ways to handle the credit balance.
First one is applying the credit balance to specific invoices. The other one is paying the money to the
customer directly.

Applying the credit balance to specific invoices

1. Select the Customer.
2. Click the Pay Credit Button.

3. Select the credit invoice that you want to pay to the invoice
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After applied the credit invoice, you can see the credit invoice no. And credit balance will reduce

4. Click the Apply Invoice button

Paying the money to the customer

1. Select the Customer.
2. Select the payment type.

3. Click the ‘Pay Credit’ button.

4. Select the credit invoice that you want to pay to the customer

Remove CR button will remove the applied credit payment.*
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5. Confirm the credit pay
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8.6. Import Quotation
When you select the customer, BLUETILL will automatically check for any open quotations.

Click the ‘Import Quotation’ button to import any open quotations.

When importing a quotation, you can change item quantities or remove items. Remaining
quantities or items can be imported later.*
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9. Refund Invoice / Credit Memo
Customer credit is considered money that you owe a customer which can be used as payment for the
customer for their invoices.
Credit is gained when you record a refund transaction/‘Credit Memo’.
This credit amount can then be refunded as Cash, Bank Transfer, etc to the Customer OR can be settled
by paying for unpaid Invoices that the customer may have.

Open Credit Memo Screen

1. Select Customer.
2. Enter the items or services you are reversing.
3. Change item details.
Functions are similar with invoice. Click here for check

Settling Credits

You can choose to settle customer credit in the following ways:
1. Apply the credit to an open invoice. You can pay for one or more of the customer’s open invoices
using the credit.
2. Refund the credit. If the customer does not have any open invoices, you can record a refund
payment for the credit amount.
Click here for instruction
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10. Quotation
Select Quotation under Activities > Sales Tab

A document sent to a potential customer offering to sell goods or services at a certain price, under
specified conditions.

Functions are similar with invoice. Click here to check
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11. Pro Forma Invoice
A ‘Pro forma Invoice’ otherwise known as a ‘Sales Order’ is a document that a seller sends to a
prospective customer to outline the details and cost of a product or service. A Pro forma invoice is sent
before the work is done, so it isn’t a “true” invoice but instead a commitment of goods or services that
have yet to be delivered.

What is the purpose of a pro forma invoice?

Pro forma Invoices are used if you need to produce a document to a customer for products or services
that you are yet to deliver. The purpose is to make sure the seller and customer are on the same page
about their agreement, most importantly the price of the products or services.

Functions are similar with invoice. Click here to check

Back order handling
A ‘back order’ is the quantity of the item to be placed on backorder.
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12. Statement
Open Quick Insight

1. Open Statement Screen

2. Select Customer for Printing or Email
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Select
Click to select the customer. If you click it, the column has ‘Y’. If you click again, the
column will be empty.

Open Invoice
Only

If you want to include open invoice only, please select this option.

Customer has
balance

If you want to see all customer, please change this option.

Send To Print or send email to customer
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13. Pos Sale

SKU, Barcode Scan or type the barcode.

Search Item Open search item screen.

Customer Name Save customer details on invoice. it doesn’t register details on customer list.

No Row number.

Qty Quantity

Unit Price GST included selling price.

Delete button Remove item.

Single Sales unit name click here for detail

Reprint Reprint receipt

Refund Refund item

Shift Open & close shift click here for detail

Shift Report Browsing shift history

Open Till Open cash drawer without sale

Total Disc Apply total discount for this sale

Paid In Open paid in & paid out screen
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13.1. Starting & Ending Your Day
One of the first steps to starting your day is to open a shift. The shift must be open before
cashiers can run any transactions at the register.
Click Here for instruction

When your business closes each day, close the shift in BLUETILL to end your day. After the shift
is closed, cashiers cannot run any more transactions.
Click Here for instruction
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13.2. Sale Item
1. Select item

You can select an item using three different methods.
(1) Scan or type the item code and click the ‘Search’ button or press ‘ENTER’ on your keyboard.
(2) Click the ‘Search Button’ to open the ‘Lookup Item’ screen.
(3) Type the item code directly.
(4) Click the ‘No.’ column on the empty row to open the ‘Lookup Item’ screen.

2. Change the quantity

Click on the ‘Qty’ column for the desired row then type the quantity.

3. Change the price

Click on the ‘Unit Price’ column for the desired row then type the price.

If you want to setup ‘Price Change’ authority, you can set it up in the ‘Staff Edit’ screen.
Click here for instruction*
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4. Click the ‘Pay’ button

5. Enter Table Number (Optional)

6. Receive Payment

Step 1 : Click on the ‘Amount Received’ column for the payment type that the customer gave.
Step 2 : Enter the amount (If customer pays the exact full amount, you can click the ‘Full Payment’
button instead).

If you want to setup ‘Table Holder Number’, you can set it up in the ‘Preferences’ screen
under the ‘Options’ tab. Click here for instruction.*

If the customer pays with more than one different payment type, enter the amount for
each type. BLUETILL displays the remaining amount automatically after you enter the*
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7. After Payment

After payment the staff login screen will be displayed.

If you want to skip the login screen and/or you don’t want to print receipt after the transaction, you can
change it in ‘Preferences’.

amount.

You can setup payment type in the ‘Payment Setup’ screen. Click here for instruction.*
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13.3. Refund
Refund by Receipt

1. Open Refund Screen

2. Select the Docket that you want to refund, Then click the Begin button.

Pos Sale Screen After clicking the button
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3. Click the Pay button

Refund by Negative Qty Entering

1. Select the item that you want to refund
2. Click the Qty on the screen, then put the minus qty

After entering the minus qty, please press the enter key.*
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14. Pos Touch Sale

1. Page button Click here for button setup instruction
2. Page Item Click here for button setup instruction
3. Selected item
4. Functions
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14.1. Starting & Ending Your Day
One of the first steps to starting your day is to open a shift. The shift must be open before
cashiers can run any transactions at the register.
Click Here for instruction

When your business closes each day, close the shift in BLUETILL to end your day. After the shift
is closed, cashiers cannot run more transactions.
Click Here for instruction
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14.2. Sale Basic Item
1. Select item

Click the page button then select page item or click the ‘Search’ button.

2. Change quantity

Click the item row then click the ‘Qty’ button.

Enter Qty
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3. Change Price

Click the item row then click the ‘Price’ button.

4. Delete Item

Select the desired row then click the ‘Delete’ button (If the item has modifiers, select the base item row).

5. Click Pay button

6. Enter Table Number (Optional)

If you want to setup ‘Price Change’ authority, you can set it up in the ‘Staff Edit’ screen.
Click here for instruction*

If you want to setup ‘Table Holder Number’, you can set it up in the ‘Preferences’ screen
under the ‘Options’ tab. Click here for instruction.*
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7. Receive Payment
Once you have added all your items, you are ready to take payment for the sale.

Click the Pay button. You will be taken to the payment screen where you will find a variety of payment
type (determined by what the store owner has chosen).

Step 1 : Click on the ‘Amount Received’ column for the payment type that the customer gave.
Step 2 : Enter the amount (If the customer pays the exact full amount, you can click the ‘Full Payment’
button instead).

8. After Payment

After payment, the staff login screen will be displayed.

If the customer pays with more than one different payment type, enter the amount for
each type. BLUETILL displays the remaining amount automatically after you enter the
amount.
*

You can setup payment type in the ‘Payment Setup’ screen. Click here for instruction.*
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If you want to skip the login screen and/or you don’t want to print a receipt after the transaction, you can
change it in ‘Preferences’.
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14.3. Sale Basic Item with Variants
If you run a cafe or a restaurant, some items may have variants like cup size or additional
toppings. Having such modifiers will open another screen to choose for the modifiers when the
item is selected.

1. Select Item (If the item has any modifiers the modifier select screen will display automatically)

2. Select Single Choice (One selection per choice of up to 4 separate single choices can be made)

3. Select Multiple Choice (Any number of selections can be made)

If you don’t want to select the modifier after selecting it, you can click the button again to
deselect it.*
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Change modifier

To edit modifiers click the Description column of the base item on the sales screen.

4. Changing quantity, price and deleting the item is the same as basic item sale.

5. Click the ‘Pay’ button

6. Enter Table Number (Optional)

7. Receive Payment

If you want to setup ‘Table Holder Number’, you can set it up in the ‘Preferences’ screen
under the ‘Options’ tab. Click here for instruction.*
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Step 1 : Click on the ‘Amount Received’ column for the payment type that the customer gave.
Step 2 : Enter the amount (If customer pays the exact full amount, you can click the ‘Full Payment’
button instead).

8. After Payment

After payment the staff login screen will be displayed.

If the customer pays with more than one different payment type, enter the amount for
each type. BLUETILL displays the remaining amount automatically after you enter the
amount.
*

You can setup payment type in the ‘Payment Setup’ screen. Click here for instruction.*
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If you want to skip the login screen and/or you don’t want to print receipt after the transaction, you can
change it in ‘Preferences’.
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14.4. Refund in Pos Touch
Refund by Receipt

1. Open Function and Refund Screen

2. Select the Docket that you want to refund, Then click the Begin button.
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Pos Touch Screen After clicking the button

3. Click the Pay button

Refund by Negative Qty Entering

1. Select the item that you want to refund
2. Click the Qty button on the screen
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3. Click the minus button first. Then click the Qty button

If the item has a variation with a price, you need to change the qty it too.*
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14.5. Table Order (optional)

New Table Order
1. Select menu

2. Click the Table button

3. Select the table that seated with customer
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4. Enter the customer count

Add Extra Order for Table
1. Click the Table button

2. The select table that you need to add an extra order
3. Click the ‘Open Table’ button

Split Table Split to two tables

Change Table Change table

Open Table Open table for add extra order

Print to Kitchen Again Print the ordered menu to kitchen

Pay Bill Open Payment screen

Table button contains the following details. 1st line is table name. 2nd line is ordered
amount. the last line is the last ordered time.*

If you have selected menus when you click the table button, it’s a new table order.*
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Print Quot Print bill quotation

4. Add extra orders
5. Click the Table button
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14.6. One Click Taking Payment
Click the ‘Cash’ or ‘Card’ button on the screen

If you click a Cash or Card button, it’s the same as clicking the ‘Full Payment’ button on the Payment
screen. It’s a shortcut of full payment by cash and card.
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14.7. Loyalty Stamp Card (optional)
It’s a simple offer of a free coffee ( or drink) when a customer has purchased a certain number of drinks.

Setup purchase drink count for a free drink

1. Select the Use Loyalty Stamp Card option
2. Enter Purchase drink count for a free drink

Use Loyalty Stamp Card

1. Click Stamp Card button on the Payment screen

2. Scan the Barcode on the Stamp card

3. After you scan the stamp card barcode, you can see the collected stamp counts. Click Add Stamp
button

4. Enter Stamp count. The default count is one.

BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 125 of 161



Stamp count displays on receipt.

Give Free Drink

1. If the collected stamp is over the free drink purchase setup, you can see the One Free and Add Stamp
& One Free button.
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One Free
Redeem the stamp. For example, If a customer collected 10 stamps, the system will
remove the 10 stamps.

Add Stamp & One
Free

Redeem and collect the stamp at the same time.

2. You can see the Free Item payment type. Use this payment type for Free Drink.
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Paid by Free Item docket sample.
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14.8. Holding Sale
You can hold up to 35 sales.

Open Hold screen

1. Hold Screen

Hold You can hold a selected item.

Memo You can save a memo for reference.

Open You can open the saved Holding sales screen.

After saved the sale, the Holding docket will be printed automatically.
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2. Open or Delete Hold Sale

1 Print Holding sale.

2 Delete Holding sale.

After opening the Holding sale, you can remove or keep it*
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14.9. Send Receipt
You can send the receipt on Reprint Screen.

Send Receipt Send receipt to email.

Print Receipt Print receipt through receipt printer.

Download Receipt Download receipt to a PDF file.

Send Invoice Send receipt as an invoice layout to email.

Print Invoice Print receipt as an invoice layout.

Preview Invoice Preview receipt as an invoice layout.

Download Invoice Download receipt as an invoice layout.
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14.10. Change Paid Type
You can change the received paid type.

1. Open Change Paid Type screen on Function screen

2. Select the transaction you want to change the payment type, then update

Step 1 : Select the transaction you want to change.
Step 2 : Select a new payment type.
Step 3 : Click the Update button.
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15. Purchase
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15.1. Purchase Order
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15.2. Receive Inventory
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15.3. Return to Supplier
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15.4. Pay a Bill
Enter bills when you get them and pay them when they’re due.

Apply the payment to one or more open invoices.

1. Select the Supplier.
2. Type the amount received next to ‘Amount’.
3. Select the payment method.
4. Enter the amounts you want to apply to one or more bills in the ‘Payment’ column. If you click the
‘Pay’ button, invoice’s due amount will be filled automatically.

Total
Cash
Amount

Total payment amount made for the supplier.

Applied
Credit

Total amount of credit currently being applied to bills.

Applied
Cash

Total amount of cash currently being applied to bills.

Payment
Balance
Left

The amount of cash that is yet to be applied to bills calculated from the ‘Total Cash Amount’
minus the ‘Applied Cash’ amount. The ‘Payment Balance Left’ must be zero before you can
record the transaction.
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15.5. Apply credit from a supplier to a bill
payment
Applying the credit to specific bills

1. Select the Supplier.
2. Click the Pay Credit Button.

3. Select the credit bill that you want to pay to the bill

After applied the credit bill, you can see the credit bill no. And credit balance will reduce
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4. Click the Save button

Remove CR button will remove the applied credit payment.*
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16. Inventory
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16.1. Adjust Inventory
Open the ‘Adjust Inventory’ screen under Activities – Inventory tab

Adjust Inventory Screen

(1) When updating the Stock Adjustment, items that have been adjusted will be marked in the ‘Stocktake’
column so that you know it has been updated. The ‘Reset Stocktake’ button resets all items to be
unmarked.
(2) Imports item list. The file format should be CSV and the file should have two columns: one titled
‘SKU’ and the other one as ‘Counted’.
(3) Shows the SKU of the selected item. You can type the item SKU and click the ‘Search’ button, or hit
‘ENTER’ on the keyboard to automatically select the item and retrieve the item details.
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(4) Searches for the item to be adjusted.
(5) A reference is required to keep track of all stock adjustments.
(6) An optional memo can be added for further details to stock adjustments.
(7) The list of items to be adjusted.
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17. Reports
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18. How to
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18.1. Find Quotation
Open the ‘Quick Insight’ screen

Click the ‘Invoice’ button (1) then select ‘Quotation’ in the option box (2) and click the ‘Load Data’ button
(3).

BlueTill BlueTill Manual - 21_en

Copyrights © 2021 Forhim Technologies Pty Ltd. Page 146 of 161



18.2. Add New Customer
You can add a new customer using three different methods.

• From the ‘Customer List’ screen.
• From the ‘Customer Lookup’ screen.
• From the Invoice/Sales Order/Quotation sales screen by selecting ‘Add Customer’ from the

customer drop-down menu.
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18.3. Add payment to invoice
How to add payment for invoice
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18.4. Add a package item
Step 1 : Open the item edit screen
Step 2 : Select the ‘Package Item’ check box.

Step 3 : Click the ‘Package’ button at the bottom of the screen.

Step 4 : Click the ‘Select Items’ button then select the items that you want to include this package

Step 5 : Double click the ‘Qty’ column to change the qty.
Step 6 : Click the ‘Close’ button (when you close the screen, the items will be saved automatically).
Step 7 : Click ‘Save’ in the item edit screen.
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18.5. Skip login / print receipt after
transaction
If you want to skip the login screen and/or you don’t want to print receipt after transaction, you
can change it in ‘Preferences’.

Open ‘Preferences’ under the ‘File’ tab

Select ‘Options’ and change the settings
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18.6. Export Invoice to MYOB
1. Click Export Data/MYOB

2. Select the Invoice you want to export

(Click the MYOB Card ID column to select the invoice.)

3. Import exported text file on MYOB

Step 1 : Click Import/Export Assistant

Step 2 : Select Import Data
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Step 3 : Select File Type (Set Import to Sales and Type to Item Sales)

Step 4 : Select Format (Set ‘Select Data is separated by’ to Comma and ‘Match Card Using’ to Card ID)
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Step 5 : Select Match Fields (Click Auto Match)

Step 6 : Import (Please back up the MYOB data file before importing)
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3. Troubleshooting

(1) Error -190 : Customer not found.

Solution
Please check the customer’s MYOB Card ID.
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18.7. Export Purchase to MYOB
1. Click Export Data/MYOB

2. Select the Purchase you want to export

Click the MYOB Card ID column to select the purchase.

3. Import exported text file on MYOB

Step 1 : Click Import/Export Assistant

Step 2 : Select Import Data
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Step 3 : Select File Type (Set Import to Purchases and Type to Service Purchases)

Step 4 : Select Format (Set ‘Select Data is separated by’ to Comma and ‘Match Card Using’ to Card ID)
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Step 5 : Select Match Fields (Click Auto Match)

Step 6 : Import (Please back up the MYOB data file before importing)
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4. Troubleshooting

(1) Error -38 : Default Account for Freight charges not specified

Solution
Step 1 : Go to the Setup menu and choose Linked Accounts then Purchases Accounts.
Step 2 : Tick the checkbox I pay Freight on Purchases and specify an account number.
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18.8. Search in Customer History
You can search the invoice no or reference in invoice.
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18.9. Setup the default cursor starting point
for Item search
Open ‘Preferences’ under the ‘File’ tab.

Select Options, then change the default search option.
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19. Our Integrations

Westpac Tyro
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